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Plan

TODAY:

1. type operators

2. dependent types

Note: This week’s material is not from the TAPL textbook;

– it is mostly from Chapter 2 of “Advanced Topics in Types and
Programming Languages” (Benjamin C. Pierce et. al, MIT Press)
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Different Kinds of Maps

What is missing?

Term → Term (λx .t)
Type → Term (ΛX .t)

Type → Type ???
Term → Type ???

Agenda today:

I Type operators

I Dependent types
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Type Operators and System Fω
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Type Operators

Example. Type operators in Scala:

type MkFun[T] = T => T

val f: MkFun[Int] = (x: Int) => x

Type operators are functions at the type level.

λX . T

Three Problems:

I Type checking of type operators

I Equivalence of types

I Abstracting over type operators
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Kinding

Problem: avoid meaningless types, like MkFun[Int,String ].

∗ proper types, e.g. Bool , Int → Int
∗ ⇒ ∗ type operators: map proper type to proper type
∗ ⇒ ∗ ⇒ ∗ two-argument operators
(∗ ⇒ ∗)⇒ ∗ type operators: map type operators to proper types
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Kinding Notation

By analogy with lambda parameter type annotation, we write:

λX :: K . T

where K is the kind of X in this abstraction
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Equivalence of Types

Problem: all the types below are equivalent

Nat → Bool Nat → Id Bool Id Nat → Id Bool
Id Nat → Bool Id (Nat → Bool) Id(Id(Id Nat → Bool)

We need to introduce definitional equivalence relation on types,
written S ≡ T . The most important rule is:

(λX :: K . S) T ≡ [X 7→ T ]S (Q-AppAbs)

And we need one typing rule:

Γ ` t : S S ≡ T

Γ ` t : T
(T-Eq)
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First-class Type Operators

Scala supports passing type operators as argument:

def makeInt[F[_]](f: () => F[Int]): F[Int] = f()

makeInt[List](() => List[Int](3))

makeInt[Option](() => None)

First-class type operators supports polymorphism for type
operators, which enables more patterns in type-safe functional
programming.
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System Fω — Syntax

Formalizing first-class type operators leads to System Fω:

t ::= ... terms
λX :: K .t type abstraction

T ::= types
X type variable
T → T type of functions
∀X :: K .T universal type
λX :: K .T operator abstraction
T T operator application

K ::= kinds
∗ kind of proper types
K ⇒ K kind of operators
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System Fω — Semantics

t1 −→ t ′1
t1 t2 −→ t ′1 t2

(E-App1)

t2 −→ t ′2
t1 t2 −→ t1 t ′2

(E-App2)

(λx :T1.t1) v2 −→ [x 7→ v2]t1 (E-AppAbs)

t −→ t ′

t [T ] −→ t ′ [T ]
(E-TApp)

(λX ::K .t1) [T ] −→ [X 7→ T ]t1 (E-TAppTAbs)
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System Fω — Kinding

X :: K ∈ Γ

Γ ` X :: K
(K-TVar)

Γ,X ::K1 ` T2 : K2

Γ ` λX ::K1.T2 :: K1 ⇒ K2
(K-Abs)

Γ ` T1 : K1 ⇒ K2 Γ ` T2 : K1

Γ ` T1 T2 :: K2
(K-App)

Γ ` T1 : ∗ Γ ` T2 : ∗
Γ ` T1 → T2 :: ∗

(K-Arrow)

Γ,X ::K1 ` T2 :: ∗
Γ ` ∀X ::K1.T2 :: ∗

(K-All)
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System Fω — Type Equivalence

T ≡ T
T ≡ S

S ≡ T

S ≡ U U ≡ T

S ≡ T

S1 ≡ T1 S2 ≡ T2

S1 → S2 ≡ T1 → T2
(Q-Arrow)

S2 ≡ T2

∀X ::K1.S2 ≡ ∀X ::K1.T2
(K-All)

S2 ≡ T2

λX ::K1.S2 ≡ λX ::K1.T2
(Q-Abs)

S1 ≡ T1 S2 ≡ T2

S1 S2 ≡ T1 T2
(Q-App)

(λX ::K .T1) T2 ≡ [X 7→ T2]T1 (Q-AppAbs)
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System Fω — Typing

x : T ∈ Γ

Γ ` x : T
(T-Var)

Γ ` T1 :: ∗ Γ, x :T1 ` t2 : T2

Γ ` λx :T1.t2 : T1 → T2
(T-Abs)

Γ ` t1 : S → T Γ ` t2 : S

Γ ` t1 t2 : T
(T-App)

Γ,X ::K1 ` t2 : T2

Γ ` λX ::K1.t2 : ∀X ::K1.T2
(T-TAbs)

Γ ` t : ∀X ::K .T2 Γ ` T :: K

Γ ` t [T ] : [X 7→ T ]T2
(T-TApp)

Γ ` t : S S ≡ T Γ ` T :: ∗
Γ ` t : T

(T-Eq)
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Example
type PairRep[Pair :: ∗ ⇒ ∗ ⇒ ∗] = {

pair : ∀X .∀Y .X → Y → (Pair X Y ),
fst : ∀X .∀Y .(Pair X Y )→ X ,
snd : ∀X .∀Y .(Pair X Y )→ Y

}

def swap[Pair :: ∗ ⇒ ∗ ⇒ ∗,X :: ∗,Y :: ∗]
(rep : PairRep Pair)
(pair : Pair X Y ) : Pair Y X

=
let x = rep.fst [X ] [Y ] pair in
let y = rep.snd [X ] [Y ] pair in
rep.pair [Y ] [X ] y x

The method swap works for any representation of pairs.
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Properties

Theorem [Preservation]: if Γ ` t : T and t −→ t ′, then Γ ` t ′ : T .

Theorem [Progress]: if ` t : T , then either t is a value or there
exists t ′ with t −→ t ′.
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Dependent Types
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Why Does It Matter?

Example 1. Track length of integer vectors in types:

Vec :: Nat → ∗
first : (n:Nat)→ Vec (n + 1)→ Int

(x :S)→ T is called dependent function type. It is impossible to
pass a vector of length 0 to the function first.

Example 2. Safe formatting for sprintf :

sprintf : (f :Format)→ Data(f )→ String

Data([]) = Unit
Data(′%′ :: ′d ′ :: cs) = Nat ∗ Data(cs)
Data(′%′ :: ′s ′ :: cs) = String ∗ Data(cs)
Data(c :: cs) = Data(cs)
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Dependent Function Type (a.k.a. Π Types)

A dependent function type is inhabited by a dependent function:

λx :S . t : (x :S)→ T

‘(x :S)→ T ’ is also written ‘Πx :S T ’ in the literature.

When T does not depend on x , degenerates to function type

Notation:

S → T , (x :S)→ T where x does not appear free in T
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The Calculus of Constructions
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The Calculus of Constructions: Syntax

t,T ::= terms
s sort
x variable
λx:t.t abstraction
t t application
(x :t)→ t dependent type

s ::= sorts
* sort of proper types
� sort of kinds

Γ ::= contexts
∅ empty context
Γ, x :T term variable binding

The semantics is the usual β-reduction.
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The Calculus of Constructions: Typing

` ∗ : � (T-Axiom)
x :T ∈ Γ

Γ ` x : T
(T-Var)

Γ ` S : s1 Γ, x :S ` t : T

Γ ` λx :S .t : (x :S)→ T
(T-Abs)

Γ ` t1 : (x :S)→ T Γ ` t2 : S

Γ ` t1 t2 : [x 7→ t2]T
(T-App)

Γ ` S : s1 Γ, x :S ` T : s2

Γ ` (x :S)→ T : s2
(T-Pi)

Γ ` t : T T ≡ T ′ Γ ` T ′ : s

Γ ` t : T ′ (T-Conv)

The equivalence relation T ≡ T ′ is based on β-reduction.
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Four Kinds of Lambdas

Example Type

λx :N. x + 1 N→ N
λf :N→ N. f x (N→ N)→ N

λX :∗. λx :X . x (X :∗)→ X → X

λF :∗ → ∗. λx :F N. x (F :∗ → ∗)→ (F N)→ (F N)

λX :∗. X ∗ → ∗
λF :∗ → ∗. F N (∗ → ∗)→ ∗
λn:N. Vec n N→ ∗
λf :N→ N. Vec (f 6) (N→ N)→ ∗
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Strong Normalization

Given the following β-reduction rules

t1 −→ t ′1
λx :T1.t1 −→ λx :T1. t ′1

(β-Abs)

t1 −→ t ′1
t1 t2 −→ t ′1 t2

(β-App1)

t2 −→ t ′2
t1 t2 −→ t1 t ′2

(β-App2)

(λx :T1.t1)t2 −→ [x 7→ t2]t1 (β-AppAbs)

Theorem [Strong Normalization]: if Γ ` t : T , then there is no
infinite sequence of terms ti such that t = t1 and ti −→ ti+1.
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Pure Type Systems

Γ ` S : si Γ, x :S ` T : sj

Γ ` (x :S)→ T : sj
(T-Pi)

System (si , sj)

λ→ { (∗, ∗) }
λP { (∗, ∗), (∗,�) }
F { (∗, ∗), (�, ∗) }
Fω { (∗, ∗), (�, ∗), (�,�) }
CC { (∗, ∗), (∗,�), (�, ∗), (�,�) }

The Lambda Cube
λ→ −→ F −→ Fω −→ CC
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Dependent Types in Coq
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Proof Assistants

Dependent type theories are at the foundation of proof assistants,
like Coq, Agda, etc.

By Curry-Howard Correspondence

I proofs ←→ programs

I propositions ←→ types

Two impactful projects based on Coq:

I CompCert: certified C compiler

I Mechanized proof of 4-color theorem
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Type Universes in Coq

The rule Γ ` Type : Type is unsound (Girard’s paradox).

Γ ` Prop : Type1

Γ ` Set : Type1

Γ ` Typei : Typei+1

Γ, x :A ` B : Prop Γ ` A : s

Γ ` (x : A)→ B : Prop

Γ, x :A ` B : Set Γ ` A : s s ∈ {Prop,Set}
Γ ` (x : A)→ B : Set

Γ, x :A ` B : Typei Γ ` A : Typei

Γ ` (x : A)→ B : Typei
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Coq 101 - inductive definitions and recursion

1 Inductive nat : Type :=

2 | O

3 | S (n : nat).

1 Fixpoint double (n : nat) : nat :=

2 match n with

3 | O => O

4 | S n’ => S (S (double n’))

5 end.

Recursion has to be structural.

1 Inductive even : nat -> Prop :=

2 | even0 : even O

3 | evenS : forall x:nat, even x -> even (S (S x)).
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Coq 101 - proofs

1 Definition even_prop := forall x:nat, even (double x).

2

3 Fixpoint even_proof(x: nat): even (double x) :=

4 match x with

5 | O => even0

6 | S n’ => evenS (double n’) (even_proof n’)

7 end.

8

9 Check even_proof : even_prop.

The 2nd branch has the type even S (S (double n′)), and Coq
knows by normalizing the types:

even S (S (double n′)) ≡β even (double (S n′))

30
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Recap: Curry-Howard Correspondence

Propositions as types in the context of intuitionistic logic.

Proposition Term & Type

A ∧ B t : (A,B)

A ∨ B t : A + B

A→ B t : A→ B

⊥ t : False

¬A t : A→ False

∀x :A.B t : (x : A)→ B

∃x :A.B t : (x :A,B)
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Curry-Howard correspondence in Coq

1 Inductive and (A B:Prop) : Prop :=

2 conj : A -> B -> A /\ B

3 where "A /\ B" := (and A B) : type_scope.

1 Inductive or (A B:Prop) : Prop :=

2 | or_introl : A -> A \/ B

3 | or_intror : B -> A \/ B

4 where "A \/ B" := (or A B) : type_scope.

1 Inductive False : Prop :=.

1 Definition not (A:Prop) := A -> False.

2 Notation "~ x" := (not x) : type_scope.
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Curry-Howard correspondence in Coq - continued

1 Notation "A -> B" := (forall (_ : A), B) : type_scope.

2 Definition iff (A B:Prop) := (A -> B) /\ (B -> A).

3 Notation "A <-> B" := (iff A B) : type_scope.

1 Inductive ex (A:Type) (P:A -> Prop) : Prop :=

2 ex_intro : forall x:A, P x -> ex (A:=A) P.

3

4 Notation "’exists’ x .. y , p" :=

5 (ex (fun x => .. (ex (fun y => p)) ..)) : type_scope.

1 Inductive eq (A:Type) (x:A) : A -> Prop :=

2 eq_refl : x = x :>A

3

4 Notation "x = y" := (eq x y) : type_scope.
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The equivalence between LEM and DNE

In intuitionistic logics, the law of excluded middle (LEM) and the
law of double negation (DNE) are not provable.

I LEM: ∀P.P ∨ ¬P

I DNE: ∀P.¬¬P → P

By curry-howard correspondence, there are no terms that inhabit
the types above.

However, ∀P.P → ¬¬P can be proved. How?

We will prove that LEM is equivalent to DNE:

1 Definition LEM: Prop := forall P: Prop, P \/~P.

2 Definition DNE: Prop := forall P: Prop, ~~P -> P.

3 Definition LEM_DNE_EQ: Prop := LEM <-> DNE.
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LEM → DNE

1 Definition LEM_To_DNE :=

2 fun (lem: forall P : Prop, P \/ ~ P) (Q:Prop) (q: ~~Q)

=>

3 match lem Q with

4 | or_introl l =>

5 l

6

7 | or_intror r =>

8 match (q r) with end

9 end.

10

11 Check LEM_To_DNE : LEM -> DNE.
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DNE → LEM

1 Definition DNE_To_LEM :=

2 fun (dne: forall P : Prop, ~~P -> P) (Q:Prop) =>

3 (dne (Q \/ ~ Q))

4 (fun H: ~(Q \/ ~Q) =>

5 let nq := (fun q: Q => H (or_introl q))

6 in H (or_intror nq)

7 ).

8

9 Check DNE_To_LEM : DNE -> LEM.

10

11 Definition proof := conj LEM_To_DNE DNE_To_LEM.

12 Check proof : LEM <-> DNE.
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Dependent Types in Programming Languages

Despite the huge success in proof assistants, its adoption in
programming languages is limited.

I Scala supports path-dependent types and literal types.

I Dependent Haskell is proposed by researchers.

Challenge: the decidability of type checking.
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Problem with Type Checking

Value constructors:

Vec : N→ ∗
nil : Vec 0
cons : N→ (n:N)→ Vec n→ Vec n + 1

Appending vectors:

append : (m:N)→ (n:N)→ Vec m→ Vec n→ Vec (n + m)
append = λm:N. λn:N. λl :Vec m. λt:Vec n.

match l with
| nil ⇒ t
| cons x r y ⇒ cons x (r + n) (append r n y t)

Question: How does the type checker know S (r + n) = n + (S r)?
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